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BIOQUANT LIFE SCIENCE: Documentation
The BIOQUANT LIFE SCIENCE 2015 documentation has improved and is now available in multiple 
formats.

TOPIC CONTENTS

PDF Manuals & Help

eBook Manuals

Protocol Video Tutorials

PDF MANUALS & HELP

• PDF Manuals are now automatically installed when BIOQUANT LIFE SCIENCE 2015 is installed.

• PDF Manuals can be opened directly from the desktop.

• The BIOQUANT LIFE SCIENCE 2015 help system now opens the PDF Manual to the
corresponding section when the help button, the ? button, or F1 is pressed.

EBOOK MANUALS

• The BIOQUANT LIFE SCIENCE 2015 manuals are also available in the EPUB3 format. Check the
installation folder that came with your BIOQUANT LIFE SCIENCE 2015 DVD for instructions on
installing the eBooks to your android tablet or iPad.

PROTOCOL VIDEO TUTORIALS

• Both the PDF and eBook Manuals now have video tutorials integrated in the Protocol chapters.

BIOQUANT LIFE SCIENCE: New Feature: Measure Cells
The new Measure Cells measurement type is used to measure cell populations from field to field. 
This tool enables quick cell measurement by ensuring that only cells within the sampling area  
are counted, automatically filtering out partial cell profiles cells cut by the region of interest, and 
preventing duplicate measurements on overlapping fields of view. 

MEASURE CELLS TRANSITION

• The Measure Cells Type replaces Auto Exclusion and Edge Rejection options in the
Object measurement type from BIOQUANT LIFE SCIENCE 2014. This means that to
measure cells field to field with auto exclusion and edge rejection, you now use the
Measure Cells measurement type instead of the Object measurement type.

• The Measure Cells type also replaces the need for the New Section (NSC;)
comment. If this comment is in an array, it is now ignored. The New Section array
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comment is no longer necessary as it has been replaced by the New button.

• All LIFE SCIENCE 2015 Templates and LIFE SCIENCE 2015 Sample Data Sets have 
been updated for the transition from using the Object type and NSC comment for 
measuring cells to using the Measure Cells Type.

• If you need help transitioning custom data sets, please contact us at 800-221-0549 
or support@bioquant.com

MEASURE CELLS

Auto exclusion and edge rejection are now built into Measure Cells.

TOPIC CONTENTS

Supported Arrays

Pixel Scan

Reject All Edges

Quick Batch Script Button/List

Tools List

New, Preview, and Measure Buttons

Learning How to Use Measure Cells

SUPPORTED ARRAYS

The Measure Cells type requires a Primary Array, such as Area or VC Area, and a Topo array. 

For most field to field cell measurement protocols, either Area or VC Area will be the primary array. 

Other, less used arrays that are supported and may be useful for alternate protocols are Density, 
Length, and Pixel Count.

PIXEL SCAN

The Pixel Scan number determines how many pixels to scan away from a thresholded object to search 
for a previously measured cell’s redraw tracing. This automatically prevents duplicate measurements 
across different fields of view.
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In most cases, the default Pixel Scan value of 3 is adequate. If the object’s redraw from the previous 
field does not align well with the object on the current field, it may be that the previous redraw is not 
being associated with the object. In this case, increasing the Pixel Scan number causes the system to 
search farther away from the thresholded object for its redrawn measurement tracings.

• To change the Pixel Scan value, enter a number into the Pixel Scan box in the Measurement 
region (Measure Cells Type).

PIXEL SCAN

The default value is 3.

REJECT ALL EDGES

The Reject All Edges checkbox is available for the Measure Cells measurement type. When activated, 
Edge Rejection ignores cells whose threshold touches the edges of the region of interest.

WHAT IS EDGE REJECTION?

• Edge Rejection filters out objects which touch the edge of the Region of Interest, so that 
partial objects are not included in the measurement.

• Edge Rejection works with all ROI types.

EDGE REJECTION CHANGE

You are no longer able to reject only the left, right, top, or bottom sides of the ROI or a 
combination of two to three sides. You either reject all sides or no sides.

QUICK BATCH SCRIPT BUTTON/LIST

Quick Batch Script is a dual purpose button/list on the Measurement region (Measure Cells Type). It 
is used to run a batch script, open the Batch Measurement Editor box, or to see the recently used list.

TOOLS LIST

The Tools List contains tools that are used to filter objects from being Preview outlined or to modify 
a preview outline. All filters can be assigned to the current (highlighted) Selected array.

For more details on the features available in the Tools List, see “BIOQUANT LIFE SCIENCE: 
Enhancements: Tools List.”
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NEW, PREVIEW, AND MEASURE BUTTONS

When the Measurement type is set to Measure Cells, the “New”, “Preview”, and “Measure” buttons 
are visible along the bottom edge of the Measurement region. These buttons do the following:

• NEW: Begins a new cell measurement session. This button should be pressed once, on the first 
field of view to be measured.

The New button allows you to start a field to field measurement session at high power within 
the sampling region, specimen contour, or structure contour tracing measured at low power. 

If New is not pressed at the beginning of a measure cells session and you are measuring at high 
power with a sampling region created at low power, auto exclusion will exclude all the cells 
because they are within another tracing.

NEW BUTTON: ONLY PRESS ONCE

The New button should be pressed only once at the beginning of a field to field 
measurement session within the Tissue Volume. If you accidentally press New in the 
middle of a field to field measurement session, the system will no longer prevent 
duplicate measurement with cells measured before the New button was clicked.

• PREVIEW: Generates preview outlines based on the current threshold and filter settings. 

No data is taken at this point; this is a preview only.

• MEASURE: Records the data from the preview outlines into the Selected array.

The preview tracings change to measurement tracings. The measurement tracings are usually 
assigned to a different color than the preview tracings.

LEARNING HOW TO USE MEASURE CELLS

There are several ways to learn how to use the Measure Cells type.

• Follow one of these Guides:

Measure Cells Type - Part 1 of 3 - Basics

Measure Cells Type - Part 2 of 3 - Measurement Filters

Measure Cells Type - Part 3 of 3 - Batch Measurement

Application - Cell Proliferation Analysis

Application - Muscle Isoform Analysis

• Read one of these chapters in the PDF Manual or eBook. Each of these chapters also contains a 
video tutorial illustrating the Measure Cells feature.

Measurement Region - Measure Cells Type

Measure Cells - Chondrocyte Proliferation Protocol

Measure Cells - Muscle Isoform Analysis Protocol
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BIOQUANT LIFE SCIENCE: Template & Protocol Changes
Several LIFE SCIENCE Templates and sample data sets have been updated to use the Measure Cells 
type instead of the Object type. The PDF and eBook Manual protocols and guides for the templates 
and sample datasets have also been updated. 

There have also been small changes to the Cell Counting - Proliferation template and sample data set 
as documented below.

UPDATED TEMPLATES/SAMPLE DATA SETS

Start Here-Basic Morphometry (Template and Sample Data Set)

Cell Counting-1 Cell Type (Template and Sample Data Set)

Cell Counting-2 Cell Types (Template)

Cell Counting-Proliferation (Template and Sample Data Set)

Muscle Isoform Analysis (Template and Sample Data Set)

START HERE-BASIC MORPHOMETRY (TEMPLATE AND SAMPLE DATA SET)

The Start Here-Basic Morphometry template and sample data set, as well as protocol, have changed 
to use the new Measure Cells type to measure labeled cells.

• Template Changes

• The Measure Cells Measurement Type has been assigned to A2 Labeled Areas.

Previously, the Object Measurement Type was assigned to A2 Labeled Areas.

• The NSC; comment has been removed from the A1 Structure Area array.

A New Section is now generated with the New button on the Measure Cells type region
instead of via array comments.

• Protocol Changes

To measure labeled cells field to field within a sampling area, you now use the new Measure
Cells Measurement Type. The Measure Cells Type is used to quickly measure cells from field
to field. This tool enables quick cell measurement by ensuring that only cells within the
measurement area counted, automatically filtering out partial cell profiles cells cut by the
region of interest, and preventing duplicate measurements on overlapping fields of view.

LEARN TO USE MEASURE CELLS

• Manual: Follow the protocol in the Measurement Type: Measure Cells chapter of
the PDF Manual or eBook Manual. This chapter includes video tutorial using the
Measure Cells measurement type.

CELL COUNTING-1 CELL TYPE (TEMPLATE AND SAMPLE DATA SET)

The Cell Counting-1 Cell Type template and sample data set, as well as protocol, have changed to use 
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the new Measure Cells type to measure labeled cells.

• Template Changes

• The Measure Cells Measurement Type has been assigned to A2 Cell Area.

Previously, the Object Measurement Type was assigned to A2 Cell Area.

• The NSC; comment has been removed from the A1 Sampling Area array.

A New Section is now generated with the New button on the Measure Cells type region 
instead of via array comments.

• Protocol Changes

To measure labeled cells field to field within a sampling area, you now use the new Measure 
Cells Measurement Type. The Measure Cells Type is used to quickly measure cells from field 
to field. This tool enables quick cell measurement by ensuring that only cells within the 
measurement area counted, automatically filtering out partial cell profiles cells cut by the 
region of interest, and preventing duplicate measurements on overlapping fields of view. 

LEARN TO USE MEASURE CELLS

• Manual: Follow the protocol in the Measurement Type: Measure Cells chapter of 
the PDF Manual or eBook Manual. This chapter includes video tutorial using the 
Measure Cells measurement type.

• Guide: The updated “Measure Cells Type- Part 1 of 3 - Basics” guide can be found 
under the “Measurement Type Guides” heading..

CELL COUNTING-2 CELL TYPES (TEMPLATE)

The Cell Counting-2 Cell Types template, as well as protocol, has changed to use the new Measure 
Cells type to measure labeled cells.

• Template Changes

• The Measure Cells Measurement Type has been assigned to A2 Cell 1 Area and A3 Cell 2 
Area.

Previously, the Object Measurement Type was assigned to both of these arrays.

• The NSC; comment has been removed from the A1 Sampling Area array.

A New Section is now generated with the New button on the Measure Cells type region 
instead of via array comments.

• Protocol Changes

To measure labeled cells field to field within a sampling area, you now use the new Measure 
Cells Measurement Type. The Measure Cells Type is used to quickly measure cells from field 
to field. This tool enables quick cell measurement by ensuring that only cells within the 
measurement area counted, automatically filtering out partial cell profiles cells cut by the 
region of interest, and preventing duplicate measurements on overlapping fields of view. 
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LEARN TO USE MEASURE CELLS

• Manual: Follow the protocol in the Measurement Type: Measure Cells chapter of 
the PDF Manual or eBook Manual. This chapter includes video tutorial using the 
Measure Cells measurement type.

CELL COUNTING-PROLIFERATION (TEMPLATE AND SAMPLE DATA SET)

The Cell Counting-Proliferation template, sample data set, and protocol have been changed to use 
the new Measure Cells type to measure PCNA+ and PCNA- cells.

• Template Changes

• Rather than multiple Topo arrays, the template now has only one Topo array. 

• The P6 PCNA+N/TtAr array has been renamed for Excel compatibility.

The previous P6 array name was: Ch.N+/Pr.Z.Ar

• The Measure Cells Measurement Type has been assigned to A2 PCNA+ Cells and A3 
PCNA- Cells.

Previously, the Object Measurement Type was assigned to both of these arrays.

• The NSC; comment has been removed from the A1 Sampling Area array.

A New Section is now generated with the New button on the Measure Cells type region 
instead of via array comments.

• Protocol Changes

The Cell Counting-Proliferation Protocol uses the new Measure Cells Measurement Type. 
The Measure Cells Type is used to quickly measure cells from field to field. This tool enables 
quick cell measurement by ensuring that only cells within the measurement area counted, 
automatically filtering out partial cell profiles cells cut by the region of interest, and preventing 
duplicate measurements on overlapping fields of view. 

FOLLOW A CELL PROLIFERATION PROTOCOL

• Manual: The Cell Counting-Proliferation Protocol in the BIOQUANT LIFE SCIENCE 
2015 PDF and eBook Manuals has been updated to use the Measure Cells Type. A 
video tutorial of this protocol is also provided.

• Guide: The updated “Application-Cell Proliferation Analysis” guide can be found 
under the “Application Guides” heading.

MUSCLE ISOFORM ANALYSIS (TEMPLATE AND SAMPLE DATA SET)

The Muscle Isoform Analysis template and sample data set, as well as protocol, have been changed to 
use the new Measure Cells type to measure Myocyte positive and negative cells.

• Template Changes
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• The Measure Cells Measurement Type has been assigned to A2 Satellite Cell Area, A3 (+)
Myocyte Area, and A4 (-) Myocyte Area.

Previously, the Object Measurement Type was assigned to these arrays.

• The NSC; comment has been removed from the A1 Whole Muscle Area array.

A New Section is now generated with the New button on the Measure Cells type region
instead of via array comments.

• Protocol Changes

The Muscle Isoform Protocol uses the new Measure Cells Measurement Type. The Measure
Cells Type is used to quickly measure cells from field to field. This tool enables quick cell
measurement by ensuring that only cells within the measurement area counted, automatically
filtering out partial cell profiles cells cut by the region of interest, and preventing duplicate
measurements on overlapping fields of view.

FOLLOW A MUSCLE PROTOCOL

• Manual: The Muscle Isoform Protocol in the BIOQUANT LIFE SCIENCE 2015 PDF
and eBook Manuals has been updated to use the Measure Cells Type. A video
tutorial of this protocol is also provided.

• Guide: The updated “Application-Muscle Isoform Analysis” guide can be found
under the “Application Guides” heading.

BIOQUANT LIFE SCIENCE: Enhancements: Threshold
The Threshold region has been redesigned and contains new features.

THRESHOLD REGION

Redesigned Threshold Region
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TOPIC CONTENTS

Select and Add: Thresholding by Scroll Wheel

Disable Threshold

Threshold Transparency is Now Threshold Opacity

Threshold Range Bars Change

Zoom and Draw/Erase Threshold Enhancement

SELECT AND ADD: THRESHOLDING BY SCROLL WHEEL

The easiest way to define a threshold now is to use the scroll wheel when using Select and Add. Once 
the starting color has been chosen, scrolling the mouse wheel up adds similar colors automatically to 
the threshold. Scrolling the wheel down removes the least similar colors from the threshold. 

1. In the Threshold region of the ribbon, click Select. 

The cursor enters the Image window.

2. With the left mouse button, click a point on one of the objects of interest.

The pixel clicked and any other pixels in the Image Window that match the selected pixel’s red, 
green, and blue intensity values are highlighted.

3. Use one of the following methods to continue to add or remove the threshold.

NOTE: You can still tap the Z key to zoom. You can also still drag to create a selection box.

• Scroll the mouse wheel up to add threshold automatically. 

Scrolling the mouse wheel up adds similar colors automatically to the threshold. 

• Scroll the mouse wheel down to remove threshold automatically. 

Scrolling the wheel down removes the least similar colors from the threshold. 

4. Click the right mouse button to exit the Image Window.

DISABLE THRESHOLD

The threshold can be disabled by clicking the Disable button so that it is DOWN to quickly turn off 
all three of the color channels. Clicking the Disable button so that it is UP will turn back on all three 
color channels.

When the stain is hard to threshold, disabling the threshold is useful because it allows the user to 
manually paint in the threshold using the Draw Threshold tool. Once the threshold is manually 
painted in, it can be automatically measured using the Measurement region.
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THRESHOLD REGION

All three color channels have been disabled.

• To disable the red, green, and blue threshold color channels, click the Disable button so that it 
is DOWN.

When the Disable button is DOWN, all three of the color channel boxes become white.

ASSIGN NOTE

You can assign the disabled state of the three channels to the active array. Then, whenever you 
select that array in the future, the channels deactivate. If you do so, however, you will need to 
assign a threshold for the next array in the Selected list that uses thresholding so that each 
threshold channel is turned ON.

• To enable the red, green, and blue threshold color channels, click the Disable button again so 
that it is UP.

Any threshold color channels that were OFF are turned back ON.

THRESHOLD TRANSPARENCY IS NOW THRESHOLD OPACITY

The Threshold Transparency drop list has been replaced with a Threshold Opacity drop list. This 
terminology is consistent with other imaging applications. The ability to adjust the opacity of the 
threshold has not changed.

THRESHOLD REGION - OPACITY LIST

Use the Opacity drop list to choose a new opacity percentage.
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THRESHOLD RANGE BARS CHANGE

Each color channel has a threshold range bar. A threshold range can be set by manually moving the 
range bars. This method, called dynamic thresholding, is usually reserved for those rare occasions 
when only one color channel is active. Attempting to threshold by moving the range bars on two or 
three active color channels can be confusing. For a better thresholding option, see “Select and Add: 
Thresholding by Scroll Wheel.”

1. Click the channel boxes for the two colors you would like to turn OFF so that they are not solid.
Only one box should be ON, or solid.

2. Choose from the following:

• To adjust the upper limit of the threshold range: Imagine that the threshold bar is divided
in half. Click toward the left edge of the threshold bar and drag left or right until the
desired upper range is reached. You do not have to actually click on the colored range.

In the Image window, pixels that have color values within the new range are
highlighted.

• To adjust the lower limit of the threshold range: Imagine that the threshold bar is divided
in half. Click toward the right edge of the threshold bar and drag left or right until the
desired lower range is reached. You do not have to actually click on the colored range.

In the Image window, pixels that have color values within the new range are
highlighted.

The current RGB Threshold Range is displayed above the Threshold range bars. The
ranges for channels which are off are also displayed.

ZOOM AND DRAW/ERASE THRESHOLD ENHANCEMENT

The Draw Threshold and Erase Threshold brush size circle now updates automatically when using the 
Z key to zoom in and out on the image.

BIOQUANT LIFE SCIENCE: Enhancements: Tools List
The Tools list in the Measurement region of the ribbon has several changes. The complete Tools list 
is only available with the Object type, Measure Cells type, and Segment Assign Type. A limited Tools 
list is also available for the Trace type. 

TOOLS LIST

Redesigned Tools List



Page 14 • BIOQUANT LIFE SCIENCE 2015 Release Notes

TOPIC CONTENTS

Tools List Changes

Outline Editor Box

TOOLS LIST CHANGES

• The “Available Filters” list has been renamed “Tools.”

• The Outline Type tools have been moved from the Editing region of the ribbon to the Outline
Editor item in the Tools list.

OUTLINE EDITOR BOX

OUTLINE EDITOR BOX

Outline Editor has replaced the Outline Type in the Editing region.

The Outline Editor box can be opened by choosing the Outline Editor option under the Tools list in 
the Measurement region. The Tools List in the Measurement Region contains options for modifying 
and filtering preview outlines before measurement. The complete Tools list is available when using 
Object, Measure Cells, or Segment Assign type. A limited Tools list is available for Trace type.

The functionality matches the Outline Type in the Editing region of the ribbon from BIOQUANT LIFE 
SCIENCE 2014.

BIOQUANT LIFE SCIENCE: New Feature: Camera Presets
Camera Presets have been added for supported QImaging digital cameras. Camera presets store 
exposure time, master gain, and white balance (red gain, green gain, and blue gain) values to a file in 
the Camera Presets folder on the hard drive. The camera preset file can be loaded later to retrieve the 
camera settings.

TOPIC CONTENTS

Save Camera Presets

Quickly Load a Camera Preset

Load Camera Preset for Editing

Load the Default Fluorescence Camera Preset File
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SAVE CAMERA PRESETS

Camera presets are saved using the Camera Setup dialog box.

CAMERA SETTINGS: SAVE PRESET

Click the Save Preset button in the lower right of the Camera Settings box

1. Adjust the camera settings as needed.

2. From the Image menu, choose Camera Setup.

The Camera Setup dialog box opens.

3. Click the Save Preset button.

The BQ Save File box opens. By default, camera preset files are stored in the Camera Presets 
folder inside the BIOQUANT LIFE SCIENCE installation folder.

4. In the file name box, type a name for the preset file.

5. Click the Save button.

QUICKLY LOAD A CAMERA PRESET

Camera presets can be loaded from either the Camera Setup dialog box or by clicking the Load 
Camera Preset button in the Image region, Live Image type.

1. In the Image region, change the Type drop list to Live Image.

2. Click the [...] button to the right of the Live / Held button. This is the load camera presets 
button.

The BQ Open File dialog box opens. By default, the box opens to the Camera Presets folder in 
the BIOQUANT LIFE SCIENCE installation folder.
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IMAGE REGION (LIVE IMAGE TYPE)

Notice the new [...] button to the right of Live/Held. This is the load camera presets button.

3. In the BQ Open File box, choose the intended camera presets file, then click the Open button.

The live image changes to reflect the new camera settings.

LOAD CAMERA PRESET FOR EDITING

If changes must be made to a camera preset, open the preset from the Camera Setup dialog box, edit 
the file, and re-save it.

1. From the Image menu, choose Camera Setup.

The Camera Setup dialog box opens.

2. Click the Load Preset button.

The BQ Open File box opens. By default camera preset files are stored in the Camera Presets 
folder inside the BIOQUANT LIFE SCIENCE installation folder.

3. Click the preset file to be edited and click the Open button.

4. After the camera settings have been edited, save the preset file again.

LOAD THE DEFAULT FLUORESCENCE CAMERA PRESET FILE

BIOQUANT provides a default fluorescence camera preset file that sets the exposure time to 100ms 
and the gain to 5. This is the longest exposure time that creates a live image that is still easy to focus.

1. Using a low power lens, such as 4x, set up the microscope for brightfield viewing.

2. Once the specimen is in focus, turn off the brightfield light and turn on the fluorescent light.

3. Switch to the lens that will be used for fluorescent imaging.

4. In the Imaging region, click the [...] button next to the Live/Held button to open the Load 
Camera Presets box.

5. On Load Camera Presets, click the “Fluorescence.cps” preset file then click the Open button.

6. Examine the image in the Image window.



Page 17 • BIOQUANT LIFE SCIENCE 2015 Release Notes

POINTERS

• To adjust the brightness of the image, adjust the output of the excitation source.

• If the excitation source is not adjustable then the gain setting in BIOQUANT can be 
adjusted instead using the Camera Setup box.

BIOQUANT LIFE SCIENCE: No Longer Supported: Analog 
Camera
The BIOQUANT LIFE SCIENCE 2015 version no longer supports analog cameras. As more and more 
features for very high resolution images are added, this backward compatibly support has become too 
hard to maintain. If you have an analog camera and would like to receive a quotation to upgrade to a 
digital camera, contact sales.

MENU ITEMS REMOVED

• On the Image menu, “Open Analog Camera” has been removed.

• On the Image menu, “Close Analog Camera” has been removed.

BIOQUANT LIFE SCIENCE: Minor Enhancements
TOPIC CONTENTS

Image Window Now Contains Full Image File Path

Large Image Navigator: Fine Move Step Now Remembered

Large Image Navigator: New Views Added: 1:8, 1:16

ROI Enhancements: Topo ROI Right Click Enhancement

Editing Region Redesign

Auto Width Type: Larger Width Symbols

Batch Editor: New Commands

Reset Parameters Expanded

Pseudocolor and Histogram Now Part of Imaging Extensions

IMAGE WINDOW NOW CONTAINS FULL IMAGE FILE PATH

The full path name of the currently open image is displayed on the title bar of the Image window and 
remains there until updated by loading a new image.

LARGE IMAGE NAVIGATOR: FINE MOVE STEP NOW REMEMBERED

On the Large Image Navigator’s Navigator Setup box, the Fine Move Step value is now remembered 
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across sessions. The Coarse Move Step value was already remembered in BIOQUANT LIFE SCIENCE 
2014.

NAVIGATOR SETUP

Fine Move Step (% of Pan Box) is now remembered across sessions of BIOQUANT.

LARGE IMAGE NAVIGATOR: NEW VIEWS ADDED: 1:8, 1:16

On the Large Image Navigator there are now two more view types: 1:8 and 1:16. This allows more 
views on very large images.

LARGE IMAGE NAVIGATOR VIEW

1:8 and 1:16 views have been added.

ROI ENHANCEMENTS: TOPO ROI RIGHT CLICK ENHANCEMENT

When using the Topo ROI Type in the ROI Tools region, if the user right clicks to cancel before 
clicking in the Image window to choose the Topo tracing, the prior ROI is redrawn.
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EDITING REGION REDESIGN

NEW EDITING REGION

Text has been added to the buttons, as well a new tool: Cut Edges

• The Type drop list has been removed, all the tools in the Editing region are now related to 
editing the threshold. The Outline Type has been moved to the Measurement region under 
Tools as the Outline Editor item. See “Outline Editor Box.”

• Text has been added to all the buttons to make their functions more obvious.

• The new Cut Edges tool has been added. Cut Edges removes all the threshold objects that touch 
the edges of the region of interest.

• The zoom level for threshold editing automatically resets to 1:1 when you right click to exit the 
Image window.

AUTO WIDTH TYPE: LARGER WIDTH SYMBOLS

The X symbols that mark the locations of the auto width measurements have been replaced with 
more visible boxes.
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AUTO WIDTH TYPE

The symbols indicating the width measurements are more prominent.

BATCH EDITOR: NEW COMMANDS

The following commands have been added to Batch Measurement. To add the new commands, on the 
Batch Editor box, click the Add button. Then, on the Add Steps box, double click the command in the 
list. 

• The “Disable Preview After Edit” command has been added. 

This checks the “Disable Preview After Edit” box on the Editing Setup box accessed by clicking 
Setup in the Editing region of the ribbon. 

Disable Preview After Edit allows a series of automated threshold editing steps to be processed 
faster since there is no need to wait for the preview tracing to update after each one.

• The “Enable Preview After Edit” command has been added.

This enables the “Enable Preview After Edit” box on the Editing Setup box accessed by clicking 



Page 21 • BIOQUANT LIFE SCIENCE 2015 Release Notes

Setup in the Editing region of the ribbon.

Enable Preview after Edit allows preview outlines to be generated after most Editing 
commands.

• A “Measure Cells New” command has been added to complement the new Measure Cells type.

This is the same as clicking the New button on the Measure Cells Measurement Type.

• A “Measure Cells Preview” command has been added to complement the new Measure Cells 
type.

This is the same as clicking the Preview button on the Measure Cells Measurement Type.

• A “Measure Cells Measure” command has been added to complement the Measure Cells type.

This is the same as clicking the Measure button on the Measure Cells Measurement Type.

RESET PARAMETERS EXPANDED

Reset parameters has been updated to match the expanded set of assignments. When you click Reset 
Parameters, the system is reset to default parameters. Make sure you click the Selected array again 
after clicking Reset Parameters to retrieve any array assignments. 
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RESET PARAMETER ACTIONS

• Additive Mode: OFF

• Subtractive Mode: OFF

• Save to Topo Array: ON

• Comment Memory Recall: ON

• Update Display by Comment: ON

• Extend to Live Image: OFF

• Live Manual Measure: OFF

• Live Redraw All: ON

• Navigator Updates Redraw: ON

• Show Landmark: ON

• Mark Object: OFF

• Label Object: OFF

• Sound: OFF

• Save Window Positions: OFF

• Threshold Opacity: 50%

• Show Threshold: ON

• Outline Filter Smoothing: 2

• Outline Filter Low Filter: 15

• Outline Filter High Filter 65535

• Measurement Filters: OFF

• Live/Held Image: Held

• Background Correction: OFF

• Imaging Extensions add-on only: Stereology Grid: Cleared.

PSEUDOCOLOR AND HISTOGRAM NOW PART OF IMAGING EXTENSIONS

The Pseudocolor and Histogram features have been moved from the core LIFE SCIENCE software 
to the Imaging Extensions add-on. This allows us in future versions to add continued support for 
DICOM images, density output tables, and monochrome cameras.
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BIOQUANT Imaging Extensions: Enhancements
TOPIC CONTENTS

microCT Navigator Enhancements

Very Large Images

Pseudocolor and Histogram: Now Part of Imaging Extensions

Pseudocolor: New Output Tables

MICROCT NAVIGATOR ENHANCEMENTS 

• Orientation reference graphics have been added to the microCT navigator to show the plane of
section and the rotation of the data.

MICROCT NAVIGATOR - Z VIEW

Note the orientation reference graphic above the Level and Window sliders.

• DICOM image handling has improved for images with the Smallest Image Pixel Value and
Largest Image Pixel Value flags.

VERY LARGE IMAGES

• BIF files can now be saved as uncompressed TIF files up to 4GB.

• TIF files up to 4GB can be saved as BIF images.
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• The Large Image Navigator can now open uncompressed TIF files up to 4GB from sources such 
as Aperio ImageScope and Photoshop CC, as long as the computer has enough memory.

PSEUDOCOLOR AND HISTOGRAM: NOW PART OF IMAGING EXTENSIONS

The Pseudocolor and Histogram features have been moved from the core OSTEO software to the 
Imaging Extensions add-on. This allows us in future versions to add continued support for DICOM 
images, density output tables, and monochrome cameras.

PSEUDOCOLOR: NEW OUTPUT TABLES

BIOQUANT LIFE SCIENCE 2015 includes two pseudocolor output table files. These files can be 
opened in the Pseudocolor box to set the color palette to predefined values. 

LOADING AN OUTPUT TABLE

• To open an output table, on the Pseudocolor box, from the File menu, choose Load 
Output Tables. 

• In the Open box, double click the desired .pal file.

•  Spectrum.pal

This palette is constructed of the colors in the visible light spectrum. 

PSEUDOCOLOR BOX

Spectrum.pal

• BlackBody.pal

This palette is constructed from the color of radiation emitted by blackbody objects at different 
temperatures.
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PSEUDOCOLOR BOX

BlackBody.pal

BIOQUANT SCAN: Enhancements
TOPIC CONTENTS

Manual Focus Enhancements

Photobleach Protection

Software Control of the PhotoFluor II

BIOIMAGER Software Control Enhancements

MANUAL FOCUS ENHANCEMENTS

BIOQUANT SCAN supports scanning with pauses for a technician to periodically adjust the focus of 
the section. A few improvements have been made to this process.

• A “Back” button has been added.

When the stage pauses to allow for refocusing, clicking the back button moves the stage to
preceding image capture positions. This is helpful if the stage is set to only stop every 3 fields of
view to adjust focus. The stage can be backed up to the 1st or 2nd field to adjust the focus and
recapture the images. Clicking the Continue button resumes automated image capture.

• The system waits before going to the next slide.

When BIOQUANT SCAN is set up to scan multiple slides in one pass, the system will pause
on the last field of view for each slide. This gives the technician a chance to use the new Back
button and recapture the last few images if needed. Clicking the Continue button resumes
automated image capture.
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PHOTOBLEACH PROTECTION

When scanning a large fluorescent section, the technician may not always be on hand to swap the 
slides when the scan is finished. To avoid photobleaching the section, two new features have been 
added.

AUTOMATICALLY CLOSE THE PHOTOFLUOR II EXCITATION SHUTTER
The PhotoFluor II is a fluorescence excitation source from 89 North. It has a serial port interface 
to the computer which allows BIOQUANT LIFE SCIENCE to control the shutter remotely.

SCAN MULTIPLE SLIDES SETUP BOX

The PhotoFluor Shutter Control checkbox appears at the bottom right 
 of the Scan Multiple Slides Setup box.

a. Begin a scan multiple slide project.

b. On Scan Multiple Slides, set the various scan areas for the samples.

c. In the Photobleach Safe Stop region, check the “Auto Close / Open Shutter” check box.

d. Begin the scan.

After the sections are scanned, BIOQUANT SCAN will close the shutter on the PhotoFluor 
II excitation source. This helps keep the sample from fading.

MOVE TO A BLANK LOCATION ON THE SLIDE
For microscopes without a PhotoFluor II excitation source, the next best option to protect the 
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sample is to move it out of the light path.

SCAN MULTIPLE SLIDES SETUP BOX

The Photobleach Safe Stop option appears at the bottom right of the Scan Multiple Slides

a. Begin a scan multiple slide project.

b. On Scan Multiple Slides, set the various scan areas for the samples.

c. Move the stage to a blank location on the last slide scanned.

d. In the Photobleach Safe Stop region, click the Set button.

e. Begin the scan.

After the sections are scanned, BIOQUANT SCAN moves the sample to the marked blank 
part of the slide. This helps keep the sample from fading.

SOFTWARE CONTROL OF THE PHOTOFLUOR II

BIOQUANT now supports software control of the 89 North PhotoFluor II illuminator. The Scan 
menu can now adjust the brightness of the PhotoFluor II as well as open and close its shutter. The 
PhotoFluor II can be controlled both by the software and by its front button panel.

SETTING UP THE HARDWARE

a. Connect the USB to COM port adapter provided with the PhotoFluor II to the BIOQUANT 
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computer.

This is adapter is needed because most modern computers have only one serial COM port. 
This port is normally used by the motorized stage controller. The drivers for the USB to 
COM port adapter are part of Windows.

b. In the device manager, configure the USB to COM port driver to use the COM2 port.

Contact BIOQUANT technical services at 615-350-7866 or at support@bioquant.com with
questions.

c. Connect the PhotoFluor II to the USB adapter using the serial cable provided with the
PhotoFluor II.

d. Contact technical services to get the BIOQUANT driver needed enable this feature in
BIOQUANT LIFE SCIENCE.

SETTING THE UV EXCITATION LEVEL

• On the Scan menu, choose the excitation throughput needed. Available settings are: Set
UV Excitation 20%, Set UV Excitation 40%, Set UV Excitation 60%, Set UV Excitation 75%,
Set UV Excitation 100%

CONTROLLING THE EXCITATION SHUTTER

• On the Scan menu choose “Open Excitation Shutter” or “Close Excitation Shutter”.

BIOIMAGER SOFTWARE CONTROL ENHANCEMENTS

A few minor improvement have been made to software control of the BIOIMAGER.

• In the Parameters region, the Mag drop list now controls the BIOIMAGER nosepiece to
automatically choose the matching objective lens.

• On the Scan menu, the Turn Light On menu item has been renamed to “Turn Transmitted Light
On” to avoid confusion with the new excitation source controls.

• On the Scan menu, the Turn Light Off menu item has been renamed to “Turn Transmitted Light
Off” to avoid confusion with the new excitation source controls.

BIOQUANT Topographer: Enhancements
TOPIC CONTENTS

Selected Arrays Box Changes

Open Data Set Change
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SELECTED ARRAYS BOX CHANGES

• Save and Load Selected Lists now work.

• The menu items “Increment Element: Current Array” and “Increment Element: All Arrays” have 
been removed.

OPEN DATA SET CHANGE

• Changing the data set in the BIOQUANT Topographer now has no impact on the open data 
set in BIOQUANT LIFE SCIENCE. When you return to BIOQUANT LIFE SCIENCE from the 
Topographer, the original data set that was open in LIFE SCIENCE is still open.
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